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Unit 1 – PivotTable Fundamentals

What is a PivotTable?

PivotTables are one of Excel’s most powerful and most overlooked features. Introduced in 1993 in the 5th version of Excel, PivotTable functionality was originally developed as a data visualisation tool by a software developer working for Lotus, Pito Salas. He is responsible for the ability to replace fifteen minutes of complicated data table and database functions with a few seconds of dragging fields into place. 

When you look at a PivotTable it looks a lot like a normal worksheet with rows and columns of data, labels, subtotals and grand totals:
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The difference is that a PivotTable allows you to rearrange the data dynamically within the worksheet. If you click a cell inside a PivotTable Excel displays the options and design tabs on the ribbon. These contextual tabs allow you to manipulate the PivotTable either by changing its style – which you can do on the design tab – or on the Options tab, refreshing its data, changing its data source, and so on. What is really useful is the ability to change the structure of the data to emphasise different aspects of that data.
When and why use a PivotTable?

A PivotTable would be useful under the following circumstances:
· You have a large amount of transactional data that has become increasingly difficult to analyse and summarise in a meaningful way;

· You need to find relationships and groupings within your data;

· You need to find a list of unique values for one field in your data;

· You need to find data trends using various time periods;

· You anticipate frequent requests for changes to your data analysis;

· You need to create subtotals that frequently include new additions;

· You need to organise your data into a format that is easy to chart. 

Anatomy of a PivotTable
PivotTables are divided into several different areas. First you have the PivotTable field list which allows you to manipulate the PivotTable. Within the field list you have the number of fields which are datatypes you can use:
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The fields are reflected in the body of the report. You change the arrangement of the fields in the PivotTable using the Field area which is at the bottom of the PivotTable field list task pane. 
If you want to change the PivotTable layout you simply drag a field name from one area to another. For example:
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The PivotTable automatically updates to reflect the new organisation. 
You can also filter the data in a PivotTable to focus your analysis. In the PivotTable Field list click the relevant field down arrow and create a filter:
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Tick the relevant check box and click OK. Excel will update the PivotTable so that only the relevant data is displayed.To clear the filter, re-enter the field list, click the field bar and click “Clear Filter”
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You can also change the look of your PivotTable by adding or changing a style. Click the Design tab and select any one of the PivotTable Styles. 
Limitations of PivotTables

The following table highlights the changes in PivotTable limits from Excel 2000 to Excel 2007
	
	Excel 2000
	Excel 2002/2003
	Excel 2007

	Number of row fields (could be limited by available memory)
	Limited by available memory
	Limited by available memory
	1,048,576

	Number of column fields
	256
	256
	16, 384

	Number of page fields
	256
	256
	16, 384

	Number of data fields
	256
	256
	16, 384

	Number of unique items in a single Pivot field (could be limited by available memory)
	8,000
	12,500
	1,048,576

	Number of calculated items
	Limited by available memory
	Limited by available memory
	Limited by available memory

	Number of PivotTable reports on one worksheet
	Limited by available memory
	Limited by available memory
	Limited by available memory


Unit 2 – Creating Basic PivotTables 

Preparing your data

PivotTables enable you to summarise and reorganise your data dynamically but you can’t summarise just any data set. In most cases, your data needs to be laid out as a data list.

Tabular Layout

A data list is more usually known as a table with distinct columns of data, each having a header. Within the list, we have a series of rows each of which has a value for each of those headers. 
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Tabular layouts are database-centric, meaning that you would most commonly find these layouts in a database. These layouts are designed to store and maintain large amounts of data in a well-structured, scalable format.
Removing Section Headings
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Removing Repeated Column Groups

The data format shown below is common but not ideal for pivoting. The headings spread across the top of the table will not only act as column labels but also as actual data values. In a PivotTable this would force you to manage and maintain six fields, each representing a different month. 
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Eliminating Gaps
Delete all empty columns within your data source. An empty column in the middle of your data source causes your PivotTable to fail on creation because the blank column, in most cases, does not have a column name. 

Also delete all empty rows within your data source. Empty rows may cause you to inadvertently leave out a large portion of your data range, making your PivotTable report incomplete. It is also good practice to represent missing values with some logical code value wherever possible.
Type Formatting

Formatting your fields appropriately helps you avoid a whole host of possible issues from inaccurate reporting to problems with grouping and sorting.
Make certain that any fields to be used in calculations are explicitly formatted as a number or currency, or any other format appropriate for use in mathematical functions. Fields containing dates should also be formatted as any one of the available date formats. 
Creating PivotTables

PivotTables are powerful and flexible Excel analysis tools. A PivotTable lets you arrange, sort and filter data sets on the fly so you can analyse it from several different perspectives with the minimum of effort.
Adding Fields

First of all you need to have a data list. In this example, there are five columns and each of the rows inside of the table contains a value for each one of those columns:
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To create the PivotTable click the insert tab on the ribbon and then click the PivotTable button. Excel will display the Create PivotTable dialogue box:
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Verify that Excel has identified your data correctly with a marquee around the selection in the worksheet. Then decide where you want the PivotTable report to be placed. The New Worksheet option is selected by default as that is the most common choice. 

Should you want to place the PivotTable on the same worksheet, then select that option and then click the collapse dialogue box button and click the target cell from where you want the PivotTable to build from. 

When you choose the New Worksheet option, Excel will create a new worksheet and displays a blank PivotTable and also displays the PivotTable Field List:
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If for some reason the PivotTable Field list is not visible on the right click any cell inside the PivotTable and then on the Options tab on the ribbon click the Field List button. You can use that button to toggle between visible and hidden states. 

Now you can move your data into place to create the PivotTable. For example to have years as column labels – along the top of the PivotTable – drag and drop the Years field into the bottom right Column Labels box. Then the company field provides the values for the row labels, by dragging that field into the Row Labels box. Once you add the Revenue field to the Values box, the PivotTable is complete. 
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Adding Layers

If you want to add another field to the report, for example Months, simply drag that field below Company in the Row Labels box. The result is:
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When Excel creates a PivotTable it puts the subtotals for each grouping at the top of the group. To move these to the bottom of the group, click any cells on the PivotTable and then on the Design contextual tab, click the Subtotals button and then Show All Subtotals At Bottom Of Group. 
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Visually, this is now a little easier to understand.
Altering Structure

The real power of a PivotTable comes when you want to rearrange your data dynamically. A task that would take several minutes if done by hand takes just a few seconds when you have summarised your data in a PivotTable. The row and column headers provide the basic structure for your PivotTable. Here, the rows are the months and the columns are the two companies Firm A and Firm B:
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If I wanted to I could change the data layout so that the companies provided the headers for the rows and the months provided the values for the column labels. To do that simply drag the position of the labels in the lower part of the PivotTable Field List task pane as desired:
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If I want to divide up my data to provide more detail then I can add second rows or column headers to create the sub-divisions. To divide months into quarters using the original orientation simply drag the quarter field to the bottom right Row Labels panel. You will see a thin grey line appearing just above the months label, or just below if I drag lower. If I drop the Quarter field above Month the result is:
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If I were to reverse the order of those two labels by putting Quarter below Month the result is:
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This arrangement doesn’t make much sense, so we will use the former orientation. If I put the Year field above the Quarter field in the Field List the result is:
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Changing a PivotTable’s arrangement shifts the emphasis of the data which allows you to examine the data from different perspectives quickly and easily.
Report Filters

A Report Filter enables you to keep your existing table structure but fill it with more specific, criteria-based, data. For example, a report filter could be used to produce a report on sales by product and salesperson in each region, as below.
With Salesperson in the Row label area, Product in Column area, net sales in value field area, Region should be placed in the report filter area of the PivotTable. Then, you get a report like this:
[image: image20.png][Lawrence
Maria
Matt

PivotTable Field List

Drag fieds betueen areas below:

V_Report Fiter

[ ColumnLabels.

Product =

= vaes

Sumofets...

Update





You can immediately switch the report filter to other regions (or a combination of them) to produce region-specific reports.

Generating Multiple Reports from One PivotTable:

Using Report Filters, we can quickly generate multiple pivot reports. To do this click anywhere inside the PivotTable, and go to the Options ribbon. From here, click on the little down arrow next to options, choose “Show Report Filter Pages”. Select the filter field for which you want multiple pages. Done! Excel produces multiple worksheets, one each for a report filter setting.

Add Multiple Report Filters
You can add more than one report filter to a PivotTable. This is a very useful way to slice and dice your data when you have lots of columns (dimensions) e.g. you could add report filters on Month, Region & Product.
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Show Report Filters in rows or columns

From the PivotTable Options ribbon, you can set how Excel should display fields in the report filter area. To find this setting click the Options button on the left side of the Options ribbon and choose the options you require in the Layout & Format tab.
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Managing Changes in Your Source Data

Dynamic Named Ranges

You can use a dynamic formula to define the source range for an Excel PivotTable. As new items are added to the table, the named range will automatically expand.
You do not create a dynamic named range by entering it into the Name Box as for static named ranges. Choose Formulas – Define Name (Insert>Name>Define in Excel 2003), then type a name for the range, e.g. Database

In the Refers To box, enter an Offset formula that defines the range size, based on the number of items in a column that doesn't contain any blank cells e.g.: 

=OFFSET(Data!$A$1,0,0,COUNTA(Data!$A:$A),7)

…or more generally:

OFFSET(reference,rows,cols,height,width)

Reference is the reference from which you want to base the offset. Reference must be a reference to a cell or range of adjacent cells; otherwise, OFFSET returns the #VALUE! error.

Rows is the number of rows, up or down, that you want the upper-left cell to refer to. Using 5 as the rows argument specifies that the upper-left cell in the reference is five rows below reference. Rows can be positive (which means below the Starting reference) or negative (which means above the Starting reference).

Cols is the number of columns, to the left or right, that you want the upper-left cell of the result to refer to. Using 5 as the cols argument specifies that the upper-left cell in the reference is five columns to the right of reference. Cols can be positive (which means to the right of the Starting reference) or negative (which means to the left of the Starting reference).

If rows and cols offset reference is over the edge of the worksheet, OFFSET returns the #REF! error.

Height is the height, in number of rows that you want the returned reference to be. Height must be a positive number. Note in the example above we have used COUNTA(Data!$A:$A) to dynamically count the number of elements in column A. This puts the “dynamic” into a dynamic named range.

Width is the width, in number of columns that you want the returned reference to be. Width must be a positive number.

If height or width is omitted, it is assumed to be the same height or width as reference.

You now base the PivotTable on the Named Range. Select a cell in the database and then choose Insert – PivotTable. For the range, type your range name, e.g. Database and continue building the PivotTable as usual. Note that if your source data is already formatted as a table, new records will automatically be included in the PivotTable analysis.
Dealing with Blank Cells
Select the entire range of data. 
Then select the Home tab on the Ribbon and choose the Find & Select icon from the Editing group. 
This brings up a menu from which you select Go To Special. 
In the Go To Special dialog box, select Blanks. 
With all the blank cells selected, start a formula by typing the “=” sign, press the up arrow on your keyboard and then press Ctrl+Enter to fill this formula in all blank cells. 
Remember to copy and paste special values to convert the formulas to values. 
Subtotals

Subtotals are undeniably an essential feature of PivotTable reporting. Sometimes you may want to suppress the display of subtotals and other times you may want to show more than one subtotal per field.
Suppress Subtotals when you have many row fields

Subtotals can be removed from your PivotTable by selecting the relevant field and then clicking Field Settings.
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In the Field Settings dialog box choose None under Subtotals. Repeat this for other row fields until the report is easier on the eye. 

Adding Multiple Subtotals for one field

You can also add customised subtotals to a row or column label field. Select the relevant row field and in the Field Settings dialog box choose Custom and select the types of subtotals you would like to see:
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Using Running Total Options

So far, every PivotTable created has used the No Calculation option for data calculations. When you want to create running totals or compare an item to another item, you have eight other options to choose from.
The nine options are on the second tab of the Field Settings dialog box. Select a cell in the values area of your PivotTable or select the Sum of Sales cell. On the Options ribbon, click the Field Settings icon in the Active Field group. Click the Show Values As tab in the Value Field Settings dialog box.

Initially the Show Values As drop down is set to No Calculation, and the Base Field and Base Item list boxes are grayed out:
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When you click the Show Values As drop down you have eight choices other than the default of No Calculation:
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% of Row shows percentages that total across the PivotTable to 100%

% of Column shows percentages that total up and down the PivotTable to 100%

% of Total shows percentages such that all the detail cells in the PivotTable total to 100%

Difference From shows the difference of one item compared to another item or to the previous item

% of expresses the values for one item as a percentage of another item

% Difference From  shows the percentage change from one item to another item

Running Total In calculates a running total

Index calculates the relative importance of items

PivotTable Tools
Layout Updates

If you have extremely large data sets – tens of thousands or hundreds of thousands of rows, or a data set connected across a network – it can be useful to defer the layout update. At the bottom of the PivotTable Field List click the Defer Layout Update check box and then take out the Month and Quarter fields. The PivotTable will not change to reflect the update:
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When you click the Update button Excel updates the PivotTable to its new state:
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Refreshing & Restarting

PivotTable data sources rarely remain static. It is important to manage data connection to ensure the PivotTable contains the most recent data available. You can display the PivotTable data connection by clicking any cell in the PivotTable and then on the Options contextual tab click the Change Data Source button:
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When you do, the Change PivotTable Data Source dialogue box appears:
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You can see here that the PivotTable draws its data from the FirmData worksheet. If you want  to change the data source you can select that source from within the workbook but notice that the Use An External Data Source option is greyed out. You can change a data source to another one of the same name and you can swap one internal data source for another or one external source for another, but not change from one source type to another. If you want to do this, you will need to create a new PivotTable instead of editing the current one. 

The following PivotTable draws its data from an Excel table. One of the major benefits of using an Excel table as a data source is that when you add a row to the table and refresh the data connection the new data appears in the PivotTable automatically.
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By comparison if you build your data based on a worksheet data list and not a formatted Excel table, that data does not update when you refresh the table. You will need to update the data source manually, using the Data Source button on the ribbon, reselecting the new range of data. Whenever you view a PivotTable always click the refresh button to include updates to the data source. Furthermore, format your table as a formal Excel data table so that updates are automatically included in the update. 
Unit 3 – PivotTable Views

Conditional formatting

PivotTables help you summarise large data collections in an Excel worksheet but it can be hard to find data that matches specific criteria just by looking at the numbers. It is much easier to change a cell's fill or text colour to indicate its relative value. Formats that change the appearance of a cell’s contents by applying rules are called Conditional Formats. Excel lets you apply conditional formatting rules to PivotTable cells and have the formats change position when you pivot the PivotTable.

Creating a conditional format is a lot like creating a filter. In each case you create rules indicating which cells you want to be affected by your actions. 

There is one notable drawback applying Conditional Formatting to dynamically adjusting PivotTables, in that you cannot choose the range by dragging the mouse from $E5:$13 (for example). You will lose the range as soon as the PivotTable grows & shrinks. You must select the range by selecting [your field name] value as the range.

Select [your field name] value range you want conditionally formatted. By moving the cursor to the top edge of your field header [your field name] you should see a small black arrow. Left clicking will select the column of data.

In the Home ribbon, click the Conditional Formatting button and select "Color Scales" of your choice (or any other option of your choice). Notice that the Color Scales is included in the Sub and Grand Totals. [image: image32.emf]
To remove the conditional formatting from the totals click the Conditional Formatting button and then select Manage Rules and then select Edit Rule. Right at the top you have three option buttons in the Apply Rule To area. Choose the third option which will remove the formatting from the totals.

[image: image33]
Sorting, Filtering and Re-ordering

When you summarise your data in the PivotTable you might want to display all the rows in the PivotTable but change the order in which they appear.

For example in the PivotTable below we have sales data for two companies broken down by month for the years 2009 and 2010:

[image: image34.png]= Sorting.xlsx - Microsoft Excel
Hone. PR oo e
4 caon o AN By =

B 2% o0 W

oS0l X ]

PivotTabie Tools

e Team | (WOPOTE R c@o@ B

- B I AT @
Foetete - | [g- L

Formatting ~ as Table - Styles - | [£1Format = | 2~ Fitter- Select~

Clpboarg_ Font 5 Aignment 5 Number 5 styles ceis aiting
86 - £ 67 B
A [ B8 Tc D E F G H T PivotTable Field List v x
£ roose s o s oreor
3 Sum of Revenue Column Labels -
4 RowlLabels |- FirmA rmB_Grand Total
5 =2009
6| January &7l 130 197
7 February 6 50 119
8 March 128 140 268
S Apil 78 126 204 =
0 May 7 17 8
11 June 88 83 171
12y u 1 38
13 August 65 48 113
14| September 108 58 166 P
15 October 82 68 150 Y Reportfiter 7 Colmnlabels
16 November 68 132 200 —
17| December 119 58 177 U
18 2009 Total %63 924 1887
19 22010
20 January 128 89 217 B RowLabels 2 s
21 February 131 126 257 e, hé
22| March 4 32 6
23 April 129 a2 171
24 May 17 102 219 | B oofer vt ate
M 4 b | Sheet3 ~Sheet2  ¥J el w7





The current PivotTable arrangement organises the data first by year and the years are sorted in ascending order. The months are sorted in date order not alphabetically. Let's say we wanted to sort the data inside the PivotTable from highest to lowest, to find the month where Firm B had the highest sales in 2009. To do that I click any cell in the field and in the column I want to sort and then on the Options contextual tab of the ribbon, in the Sort and Filter group I can click one of three buttons:

 SHAPE  \* MERGEFORMAT 



You can sort smallest to largest, largest to smallest or create a custom sort. In this case clicking largest to smallest results in:
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You can see Excel has sorted the PivotTable data within each year based on the month for Firm B. These changes can be removed by using Undo. Sorting a PivotTable moves the data you wish to highlight to the top of the PivotTable enabling you to concentrate on the values you want to focus on. 
Slicers (2010 only)

When you filter a PivotTable Excel indicates a field has been filtered by placing filter icons in the body of the PivotTable and in the PivotTable field list. These icons are small and hard to see and give no indication which values are include in or excluded from the filter. In Excel 2010 you can filter your PivotTables using Slicers which graphically indicate which values are being used by the filter.
To filter a PivotTable using the values in a field, click any cell to activate the PivotTable and then on the Options tab, click the Insert Slicer button to display the Insert Slicers dialogue box: 
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You can now tick the box next to any of the fields for which you want to create a Slicer, for example “Month”, and click OK:
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Excel creates a Slicer that has an entry for each month that is displayed in the PivotTable. When Excel created the Slicer it isn’t large enough to display all the values, so resize the Slicer using the handles at the edges. 

To display only those values for the month of May, just click May and Excel displays only those values for 2009 and 2010 for the month of May. 
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To see the values for May and August only, select the first and then CTRL and click the second month you want to display. After you release the left mouse button Excel updates the Slicer to indicate that both May and August are both selected and the PivotTable updates appropriately. 
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To see all the data for January through to April, instead of CTRL and clicking each individual month, SHIFT and click January and then April and every month in that range will be selected.
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If you want to clear a filter applied by a Slicer click the Clear Filter icon at the top right corner of the Slicer. 

You can create Slicers from more than one field at a time. To filter by both Month and Company, click any cell in the PivotTable then choose Insert Slicer once again and select a Slicer for Company. 
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The Company Slicer will then be added to the display:
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To see the values for Firm B in August and September, click Firm B in the Company Slicer and then August and CTRL click September in the Month Slicer. The PivotTable will update accordingly:
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I can then reset the filters by clicking the Clear Filter icon at the top right of each Slicer. I can remove the Slicers by right-clicking on the Company Slicer and in the short cut menu choose Remove Company and the same for the Month Slicer. 
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Filtering your PivotTables using Slicers helps you and your audience visualise which values are included and excluded from your filter. Slicers work best for filtering fields with 20 or fewer unique values, especially if your PivotTable takes up more than half the screen after you apply the filter. 

You have a lot of control over the Slicer's appearance other characteristics so you can customise it to meet your needs. To visually distinguish the Slicers from the body of the PivotTable you can change the appearance of a Slicer by clicking it and on the Options contextual tab choose a Slicer Style from the gallery, click the drop down arrow for more style options:
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The result can be quite dramatic:
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To create your own custom Slicer style, click the more button at the bottom of the Slicer styles gallery and then click New Slicer Style:
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Then use the controls to create the style that you want. Give the style a name, select the Header option and click Format:
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Apply whatever formatting you need to that element and then click OK:
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When you click OK Excel displays a preview of the Style on the right hand side. When you click OK again your Slicer style will appear in the gallery under Custom:
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Once applied the result is this:
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You can change the caption of a Slicer by selecting the relevant Slicer and on the Options contextual tab edit the value in the Slicer selection box:
[image: image53.png]Xl 9

Pagelayout  Formulas

FormatSlicersx

Data

Developer

Options

TN = | ©)

0@ o @R

Sticer Caption: ?

& Bring Forward = |2~

Columns: 1

41 Heignt: 701 em

Financal vear - Basenamacwera - I8 | ] wegnt 0s7en 2
(8 Siicer ettings | Commctons = By selectionPane  Sh- | S} Wigtn: assam 5| e Width: S06am T
Sicer Sicerstytes Arrange Sutton: size 5|
Vear B %
7 S — o
i
2
3
0
s
6 anuay o 1m0 aw
7| Februay @ s a9
8 Morn 2 w0 s
A w ous
0] ey o o
1| e ® & om
2| oy % 1 E)
5| August s @ o
1| september 0 s s
15| ocober 2 s 10
16| Novemver @ wm o
17| December 1w s
P13 - 2010 %61 g5 1%
9] sanuary m e owr
2| Feoruary B o7

v 3] Sheeta /Sheetl

Sheet2""Sheet3 t3

Ready | 7] |





You can also change a Slicer’s layout. For example, to change the Month column into two columns, select the Month Slicer and on the Options contextual tab in the Buttons group, edit the values in the columns box to the number you want: You can also change the height and width of an individual button:
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Slicers provide a visual representation of the PivotTable's filters so take care to format them so they are visually distinct from, and yet do not overwhelm, the data in the PivotTable itself.
Saving Custom Views

You can use a custom view to save specific display settings (such as column widths, row heights, hidden rows and columns, cell selections, filter settings, and window settings) and print settings (such as page settings, margins, headers and footers, and sheet settings) for a worksheet so that you can quickly apply these settings to that worksheet when needed.

You can also include a specific print area in a custom view. You can create multiple custom views per worksheet, but you can only apply a custom view to the worksheet that was active when you created the custom view. If any worksheet in the workbook contains an Excel table (2007) or Excel list (2003), the Custom Views command will not be available anywhere in the workbook.

Unit 4 – PivotTable Calculations
Calculated Fields and Items
PivotTables enable you to analyse your data efficiently but some questions can only be answered by performing calculations on the data used to create the PivotTable. To perform that type of analysis you can create custom fields which summarise PivotTable data using a formula. Without calculated fields you would have to copy the data from the PivotTable and paste it onto another worksheet and create the formula there which is a pain. 

The button to create a calculated field is found on the Options contextual tab in the Calculations group, Click the “Fields, Items & Sets” drop down and the Calculated Field button. 
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When you click Calculated Field the Insert Calculated Field Dialogue box appears:
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You can now give your calculation a name, such as Average Sale, and create the formula. Click into the formula box and delete the 0. Now insert fields and any mathematical operators you need. For example:
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Excel adds the average sale field to the body of the PivotTable, building a further analysis into the table. Note that even though the newly calculated field appears in the PivotTable field list, it hasn’t been added to the original data source. The new field only exists in the PivotTable’s data cache – its temporary memory. Calculated fields extend the type of analysis you can perform in Excel, making PivotTables even more useful. 
Calculated Item

Let’s say we want to insert a new item in a Product drop down say, Home & Electronics. This particular field, when selected from the drop down, should show us the combined totals for both Home Décor and Electronics. Select either the particular row field or the column field in which you would like to insert a new item. Click on the particular field (where you would like to insert a calculated item) in the PivotTable and then click the “Options” tab in the ribbon. Click the “formulas” button and select “Calculate Item”.
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You can now either write your own formula or use the existing items in that field and insert them by double clicking. In our case, we will insert a new item by writing something like =’Electronics’+'Home Décor’

[image: image59.png]Insert Calculated Item in “Product”

Neme:

Formula:

Fields:

Electronics & Home.

= Electrorics + Home Décorl

Items:

Product
Honth
Region

Sales Manager
Sales Target
Actual sales

Electronics
Home Décor
Industral

Insert Figld

[ _erien





Let’s provide it the name that we decided earlier – “Electronics & Home”. Press OK. What this will do is to insert a new calculated field, one which would show the combined sum of Electronics and Home Décor. If you look at the PivotTable now, you will see that under the Product field, a new item has been inserted and which sums up the relevant figures both from Electronics and Home Décor.

Another interesting way to create calculated items in a PivotTable is the use of relative references. In the above example, we clubbed two items into a single new item – “Electronics & Home” which contained the totals for both the fields. In the Calculated Field creation box, we could have written = Product[-3] + Product[-2] instead of =’Electronics’+'Home Décor’ (assuming that these two fields immediately precede the new calculated field that we are creating. The [-3] and [-2] actually tell the application to pick up and sum the preceding two fields.

[image: image60.png]Insert Calculated Item in “Product”

Neme:

Formula: | =Product-3]+Product[-2]

Fields: Items:
Product Electronics
Honth Home Décor
Region Industral

Sales Manager
Sales Target
Actual sales

Electronics & Home.

Insert Figld





A parameter value of [-1] would have made the application pick an item 1 step backwards and a value of [5] would make it pick up an item 5 steps forward. Again like the calculated field, a calculated item can use operators like +,-, / and * and other relevant excel formulas. For example a calculated item formula of =IF(Product[-1]>23000000,1,0) +Product[-2] would add 1 to Product[-2] if the total value for Product [-1] exceeds 23,000,000.

Managing & maintaining PivotTable calculations
When you find yourself maintaining and managing your PivotTables through changing requirements and growing data, you may find the need to maintain and manage your calculated fields and calculated items as well. 

Editing and Deleting Your PivotTable Calculations

Activate the Insert Calculated Field or Insert Calculated Item dialog and select the Name drop down. Once selected you have the option of deleting or modifying the item or field. 
Changing the solve order of your calculated items
If the value of a cell in your PivotTable is dependent on the results of two or more calculated items, you can specify the order in which the individual calculations are performed. 
To get to the Solver Order dialog box place your cursor anywhere in the PivotTable, select Formulas on the Tools group and then select Solve Order. 
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The Solve Order dialog box lists all the calculated items that currently exist in your PivotTable. Select any of the calculated items and using the Move Up and Move Down buttons, rearrange the order of calculations as required.
Documenting Your Formulas

To list your PivotTable calculations, simply place your cursor anywhere in the PivotTable and select Formulas and then select List Formulas. Excel creates a new tab in your workbook listing the calculated fields and calculated items in the current PivotTable. 

Unit 5 – PivotCharts 
What is a PivotChart?
PivotTables help you summarise large data sets efficiently but it can be difficult to interpret data when all you have to go on is the raw numbers. Charts summarise the data visually making it easier to distinguish groupings and trends in your data. Just as you can create charts based on regular worksheet data sets, you can create dynamic charts called PivotCharts from the data in a PivotTable.

Creating a PivotChart
There are two ways to create a PivotChart. You can either create a PivotTable and a PivotChart at the same time or you can create a PivotChart from an existing PivotTable. 

To create a PivotTable and a PivotChart at the same time you need to make sure your source data is laid out as a data list or, preferably, an Excel table. Then on the Insert Tab, click the PivotTable button down arrow and click PivotChart.
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When you do, the create PivotTable with PivotChart dialogue box opens. You can then verify that Excel has identified the range properly i.e. your table. You can then choose where to position it. 
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After you create your PivotChart you can arrange the fields using the controls in the PivotTable Field List task pane, just like you would in a PivotTable.

For example:
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Now we’ll create a PivotChart based on an existing PivotTable. To do this, display a sheet that contains a PivotTable and click any cell in the PivotTable:
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Then create a chart the way you would normally in Excel. Click the Insert tab, and then select the type of chart you want to create. For example, a clustered column chart:
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Excel has created a chart that reflects the organisation of the PivotTable. You can Pivot the PivotTable to change the PivotChart. For example, if we pulled the month field out of the axis categories area, the result will be a column chart for FirmA and FirmB for 2009 and 2010:
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Note that there are some differences between ordinary charts and PivotCharts. For example you can’t switch the row or column orientation of the PivotChart by using the select data dialogue box. This isn’t a problem, however, because you can always rearrange your data by pivoting the PivotChart. 

You can’t create XY Scatter charts, Stock Charts or Bubble Charts. Plus if you refresh the PivotChart you will remove trendlines, data labels, error bars and various other settings. 
If you would rather have a PivotChart on a separate chart sheet, click the PivotChart, and then on the Design contextual chart, click Move Chart and select where you want the chart to go. 

PivotCharts provide an overview of your data, providing insights you might not discover from looking at your raw numbers. You’ll find that PivotCharts are powerful tools that allow you to effectively analyse your data. 
PivotChart Rules

As with other aspects of PivotTable technology, PivotCharts come with their own set of rules and limitations. The following sections give you a better understanding of the boundaries and restrictions of PivotCharts

Changes in the underlying PivotTable affect your PivotChart
PivotCharts are merely an extension of your PivotTable. If you refresh, move a field, add a field, remove a field, hide a data item, show a data item or apply a filter, your PivotChart will update accordingly. 

Some formatting limitations still exist in Excel 2007

You cannot use XY (Scatter) charts, bubble charts or stock charts when creating a PivotChart
Applied trend lines are often lost when adding or removing fields in the underlying PivotTable.
You cannot switch the data source feed from rows to columns (or vice versa) as with a standard chart

The data labels in the PivotChart cannot be resized.
PivotChart Alternatives

One alternative to PivotCharts is a dynamic chart which updates depending on the status of tick boxes. First make sure your data is clean and arranged neatly, as below:
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Since the data has 3 series (sales, profits and number of customers), create 3 check boxes and place them somewhere on the worksheet. Insert these check boxes from the developer ribbon / Form Controls toolbar:


[image: image69]
We want the check boxes to tell whether to show or hide a particular series of data in the chart. So, using the Properties button on the Developer ribbon from the Control tab link each check box to one cell, say C13, D13 and E13:
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We will use an IF formula to test our data based on what the check boxes say. So, create a similar table and load it with IF formulas like this:

=IF(C$13=TRUE,C4,NA())
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Finally, make a chart with the data in this new table you created and format accordingly. 

Unit 6 – Working with Data Sources
Consolidating multiple sheets or ranges of data
Most of the time you will create a PivotTable from a data list or Excel table, but you can also summarise multiple data ranges using a PivotTable if the data is formatted appropriately. 
To consolidate a series of data ranges into a PivotTable the ranges must be laid out in cross-tabular format and have exactly the same structures. For example:
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Note the “Region-Year” Field. Normally in a cross-tabular table you would split these headings into separate cells and rows. To consolidate multiple ranges, the region containing the data and all the labels must be perfectly rectangular,therefore there must be data in each one of the cells and no blanks. The data on the other worksheets has the exact same layout.  

If you want to create a PivotTable using this data you need to do something a little different to how you would usually create a PivotTable from a data list or Excel. You need to run the PivotTable Wizard which can be accessed by holding down:

Alt + D + P
The wizard will launch. On the first page, select the multiple consolidation ranges option and click next:
 SHAPE  \* MERGEFORMAT 



Then select the “I will create the page fields” option and click next:
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On the next page you can select the worksheet ranges you want to consolidate:
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In the range field, click the collapse dialogue box button, then select the cells that contain the data on the first worksheet. Expand the dialogue box, then click Add. Repeat for each range. 

We don’t want page fields/report filter fields so leave that set to 0 and click next.  On the final page of the wizard,select the new worksheet option and click finish. The data will immediately be pivoted:
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Notice in the PivotTable field list that the fields have the names “Row”, “Column” and “Value”. To change these titles, click any cell in the PivotTable with a value for the field I want, for example “North” which is part of the “Row” group. To change the name of the active field, click on the Options ribbon and in the Active Field box change the name appropriately; for example, to “Region”:
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The name of the field will change over in the PivotTable field list. Consolidating multiple data ranges occurs relatively infrequently but can be useful when dealing with legacy workbooks which have data laid out in cross-tabular format.  
Using external data sources (Excel)
Excel enables you to build PivotTables from data found both inside and outside the workbook where you create the PivotTable. If you want to create a PivotTable from a data source that you either can’t or don’t want to import into Excel directly, you can create a connection to that data source and work with it in place.

If you want to create a PivotTable using data from another Excel workbook, go to the Insert ribbon and click the PivotTable button. In the Create PivotTable dialogue box, click the Use External Data Source option and click “Choose Connection”. 


[image: image78]
In the Existing Connections dialogue box, if the connection or the data source you want already appears then simply click it and click Open. Otherwise, click the Browse For Button:
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This will display a version of the Open dialogue box, Select Data Source. Browse for the data you want and then click open.
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The select table dialogue box will appear, showing the different data sources available in the target data source to create the PivotTable:
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Note that the first row of the data is assumed to have headers. Click OK and Excel will send you back to the Create PivotTable dialogue box. Now create a PivotTable as normal: 
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You can Pivot this, filter, add styles as usual. One important thing to note is that if you use an Excel workbook as your data source, you cannot open it while the workbook with the PivotTable is open. You will get an error message indicating that the file is in use and cannot be opened. Once you close the PivotTable workbook, the external file can be opened as normal. 

If possible, you should always draw the data for the PivotTable from the original source so that any changes in that source are reflected in the PivotTable. 

Using external data sources (Access)
Some small businesses maintain important business data in an Access database. You can create a PivotTable based on the original database table instead of importing the data into Excel.
To create the PivotTable, click the Insert ribbon and then the PivotTable button. In the Create PivotTable dialogue box, select the Use External Data Source option and then click Choose Connection:
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The connection we want doesn’t exist in the existing connection list so click Browse For More:
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Then navigate to the Access database in question, select and click OK. You will be returned to the Create PivotTable dialogue box and you should create the PivotTable as normal. The result will be this:
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You now follow the usual procedures for adding items to the Column Labels, Row Labels and Values sections of the PivotTable Field list:
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Creating a PivotTable by connecting to an Access database table saves you the trouble of importing the data into your workbook. However, you must be able to connect to the database with the file on the same computer or on the network, for the PivotTable to have the most current data. If this might potentially be an issue, then you should import the data into Excel and create your PivotTable from that imported data.

These techniques also allow you to connect to an Online Analytical Processing – or OLAP – cube such as those produced by SQL Server. 

Unit 7 – Automating PivotTables with Macros
Introducing Macros
When you work with PivotTables you will often find you want to recreate a particular configuration. You could write down the fields and the order in which they appear but it is far easier to record a macro that configures the PivotTable for you.

Recording PivotTable macros
For example, here is a PivotTable with sales data for Firm A and Firm B, monthly for years 2009 and 2010. The Quarter field also appears in the Report Filter area. The macro recorder will enable us to rebuild this configuration automatically.
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The first thing we need to do is start recording the macro. To do that, click the View tab on the ribbon, click the Macro button down arrow and Record Macro:
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Type in a macro name (without spaces) and click OK:
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Excel will now start recording your actions. The first step to recording a PivotTable macro in Excel is to clear the entire PivotTable and recreate it from scratch. With a cell in the PivotTable selected click the Options ribbon, click Clear and then Clear All. You can now recreate the PivotTable from the start.
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To stop recording, return to the View tab, Macro dropdown and click Stop Recording.
To view the macro you can do so by opening it in the Visual Basic editor. In the View ribbon, Macro drop down and View Macros. In the macro dialogue box make sure the macro you want to view is displayed and highlighted and click edit.
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When you do the macro opens inside the Visual Basic editor:
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Sub PivotMe ()

PivotMe Macro

With ActiveSheet.PivotTables("PivotTable3").PivotFields ("Year")
.orientation = xlRowField
.Position = 1

End With

With ActiveSheet.PivotTables ("PivotTable3").PivotFields ("Month")
.orientation = xlRowField
.Position = 2

End With

ActiveSheet.PivotTables("PivotTable3") .AddDataField ActiveSheet.Pivo
"PivotTable3") .PivotFields ("Revenue”), "Sum of Revenue”, xlSum

With ActiveSheet.PivotTables ("PivotTable3").PivotFields ("Quarter™)
.Orientation = xlPageField
.Position = 1

End With





There is a lot going on when you create a PivotTable macro! You can see the macro has translated movement of fields into particular positions into individual lines of code. Don’t try to write this code from scratch – there are far too many opportunities for human error – but feel free to record as many macros as you need to end up with the correct configuration of your PivotTable. 
The Power Pivot add-in (2010 only)
If you have ever tried to create a PivotTable from a file containing hundreds of thousands of rows of data you might have noticed some performance issues. Power Pivot, a new technology introduced alongside Excel 2010, uses advanced data handling techniques to let you manipulate large data sets more efficiently. You should think about using Power Pivot if you are throwing around hundreds of thousands of rows of data in Excel and finding the usual PivotTable tool struggles to keep up. 
You can download the Power Pivot add-in from www.powerpivot.com. 
Unit 8 – Summary

Frequent PivotTable Questions and Answers
I keep getting the error “The PivotTable field name is not valid”

If you don’t have one of your headings in place and you force the selection of data you’ll get a horrible error message: You need to go back and ensure every field has a heading.

When I refreshed my PivotTable, my data disappeared

You can force this by creating a PivotTable on the same sheet, populate it, and then change Sales to Sells and refresh the table. Solve this simply by dragging the new field onto the pivot

My PivotTable always uses Count instead of Sum

Note that even one blank cell convinces the PivotTable it is dealing with text data, so it will automatically use the Count analysis. Switch to SUM and it will work, it’s just more of an annoyance than anything else. Best practice, keep the data robust.

My PivotTable constantly adjusts the columns in my workbook to autofit the headings 

You can force this by altering columns widths on your PivotTable, then refreshing. If you right click on the PivotTable and choose PivotTable Options, on the Layout & Format tab untick Autofit Column Widths On Update.
The Defer Layout option locked me out of other functionality such as sorting, filtering, group.

You use the Defer Layout option when you are creating a PivotTable from a massive data source, changing the layout can be sluggish. Therefore tick “Defer Layout Update” at the bottom of the Field List pane and only update when your choices have been made. Note you will be frozen out of sorting etc. If the data source continues to grow consider using the Power Pivot add-in.
Older versions of Excel do not open my PivotTable properly

Save your spreadsheet in the 97-2003 file format. Advanced features used in later versions will be stripped out if opened in earlier versions of Excel.
When I try to group a field I get an error message

You cannot group a text field, or date fields with text or blanks, or date fields formatted as text, or fields in the report filter area.

My PivotTable shows the same data item twice

Check you haven’t got a space at the end of the value.
Deleted data items still show up in the filter area

You can force this by filtering your PivotTable on the worksheet, then deleting out all the, say, EAST records. East will still show up in the Region filter and is still accessible as a filter option, plus the data is still in the cache so you can still drill down into it. Remedy this either by rebuilding and refreshing or right clicking and choosing PivotTable Options and on the data tab, setting the number of items to retain per field to None.
I refreshed my PivotTable and now my calculated fields are displayed as error values

Check that a field used in the calculation has not been renamed or deleted. If it has, you will need to edit the Calculated Field accordingly

How do I make my PivotTable refresh automatically?

In PivotTable Options, select the Data tab, and tick Refresh data when opening the file.  

How do I refresh all PivotTables in a workbook at the same time?

As above for all, or write code. Note you still need to Refresh when your source data changes. 
How can I sort data items in a unique order that is not ascending or descending?

You can rearrange data items in your PivotTable manually by simply typing the exact name of the data item where you would like to see its data. You can also drag the data item where you want it. You can also rearrange lists according to built-in Custom Lists. 
How do I turn my PivotTable into hard data?

Simply achieved by using Copy Paste/PasteSpecial - Values

Is there an easy way to fill the empty cells left by row fields

See “Dealing with blank cells” in Unit 2 – Creating Basic PivotTables above.
Is there an easy way to fill the empty cells left by row fields in many columns

See “Dealing with blank cells” in Unit 2 – Creating Basic PivotTables above.

Why does my PivotChart exclude months for certain data items?

This is simply because there is no data for those months. To view them anyway, right click on the date field and in Field Settings from the Layout & Print tab choose Show Items with no data.
How do I add a rank number (i.e. 1-10 Sales figures) to my PivotTable?
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How do I hide calculation errors in my PivotTable?

In PivotTable Options on the Layout & Format tab, tick For Error Values Show, then enter a replacement value.
How can I reduce the size of my PivotTable reports?

Creating a PivotTable almost doubles the size of a workbook. Simply copy this PivotTable sheet to a new workbook. If you then need the source data, double click on individual cells or on the Grand Total to rebuild data.
How can I easily create a separate PivotTable for each market?

Drop the Market field into the Report Filter and choose Show Report Filter Pages from the PivotTable Options drop down. 
How do I avoid the need to constantly redefine my PivotTable’s data range?

Create a dynamic named range, then create a PivotTable using the name of that range (Unit 2 – Creating Basic PivotTables see above).
How Do I Move the PivotTable?

On the Options ribbon, choose Move PivotTable.
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